
QGIS Application - Issues

# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

21617 Bug report Open Normal Vector styling: Data Defined Override "Assistant" and expression editor do not work together 2019-03-19 03:28 PM

21617 Bug report Open Normal Vector styling: Data Defined Override "Assistant" and expression editor do not work together 2019-03-19 03:28 PM

21590 Bug report Open Normal Styles are removed from favourites if they are renamed 2019-03-15 05:24 AM

21590 Bug report Open Normal Styles are removed from favourites if they are renamed 2019-03-15 05:24 AM

21541 Bug report Open Normal Pseudocolor renderer - discrete color ramp interpolation ignores specified Min/Max 2019-03-10 05:55 PM

21541 Bug report Open Normal Pseudocolor renderer - discrete color ramp interpolation ignores specified Min/Max 2019-03-10 05:55 PM

21519 Bug report Open High Processing "Build virtual vector" now fails in certain cases Victor Olaya 2019-05-21 09:43 AM

21519 Bug report Open High Processing "Build virtual vector" now fails in certain cases Victor Olaya 2019-05-21 09:43 AM

21296 Bug report Closed High Regressions in processing "Tile Index" tool Nyall Dawson 2019-02-19 03:54 AM

21296 Bug report Closed High Regressions in processing "Tile Index" tool Nyall Dawson 2019-02-19 03:54 AM

21108 Bug report Open Normal Pseudocolour classification from QGIS 2.x qml is deleted by the 3.x layer properties dialog 2019-01-28 10:57 AM

21108 Bug report Open Normal Pseudocolour classification from QGIS 2.x qml is deleted by the 3.x layer properties dialog 2019-01-28 10:57 AM

21052 Bug report Rejected Normal Layer>Save As>Autocad DXF produces DXF that crashes AutoCAD 2019-01-21 07:24 AM

21052 Bug report Rejected Normal Layer>Save As>Autocad DXF produces DXF that crashes AutoCAD 2019-01-21 07:24 AM

20965 Bug report Open Normal unsaved features duplicated after "Making permanent" a temporary scratch layer 2019-01-11 05:44 AM

20965 Bug report Open Normal unsaved features duplicated after "Making permanent" a temporary scratch layer 2019-01-11 05:44 AM

20946 Bug report Open Normal bug: raster layer style shown in "Layers" panel is not updated when style is changed from the "Style Manager" tab 

in the Layer Styling panel

2019-01-28 10:59 AM

20946 Bug report Open Normal bug: raster layer style shown in "Layers" panel is not updated when style is changed from the "Style Manager" tab 

in the Layer Styling panel

2019-01-28 10:59 AM

20698 Bug report Closed High Processing: saga patch does not run successfully (Unknown option 'INTERPOLATION') Nyall Dawson 2018-12-04 01:35 AM

20698 Bug report Closed High Processing: saga patch does not run successfully (Unknown option 'INTERPOLATION') Nyall Dawson 2018-12-04 01:35 AM

20696 Bug report Closed High Processing: r.plane does not run successfully 2018-12-03 11:54 PM

20696 Bug report Closed High Processing: r.plane does not run successfully 2018-12-03 11:54 PM

20665 Feature request Closed Normal patch: better documentation for inconsistent behaviour of x_at (and y_at) Yves Jacolin 2018-11-29 05:32 PM

20665 Feature request Closed Normal patch: better documentation for inconsistent behaviour of x_at (and y_at) Yves Jacolin 2018-11-29 05:32 PM

20601 Bug report Reopened Normal bug: Raster calculator produces empty results layer and no error message if input layer is one that has been 

renamed in QGIS layers panel

Alessandro 

Pasotti

2019-01-21 11:34 AM

20601 Bug report Reopened Normal bug: Raster calculator produces empty results layer and no error message if input layer is one that has been 

renamed in QGIS layers panel

Alessandro 

Pasotti

2019-01-21 11:34 AM

20573 Bug report Closed High Regression: outputs of processing models are not assigned the specified styles 2019-05-09 12:39 PM

20573 Bug report Closed High Regression: outputs of processing models are not assigned the specified styles 2019-05-09 12:39 PM

20559 Bug report Open Normal Copy>paste  from a grass polygon layer gives unexpected results 2019-01-28 10:52 AM

20559 Bug report Open Normal Copy>paste  from a grass polygon layer gives unexpected results 2019-01-28 10:52 AM

19391 Bug report Open Normal Grass algorithms give incorrect output if selecting an attribute column named "cat" 2018-07-13 01:10 PM

19391 Bug report Open Normal Grass algorithms give incorrect output if selecting an attribute column named "cat" 2018-07-13 01:10 PM

19377 Bug report Closed High v.buffer processing algorithm fails when using option "Name of column to use for buffer distances".  Alexander Bruy 2019-01-25 12:02 PM

19377 Bug report Closed High v.buffer processing algorithm fails when using option "Name of column to use for buffer distances".  Alexander Bruy 2019-01-25 12:02 PM

18949 Bug report Open Normal Data Source Manager - Filter does not consider the Name and Abstract fields when displaying ArcGIS Map Server 

and ArcGIS Feature Server layers

2018-05-14 07:58 AM

18949 Bug report Open Normal Data Source Manager - Filter does not consider the Name and Abstract fields when displaying ArcGIS Map Server 

and ArcGIS Feature Server layers

2018-05-14 07:58 AM

18215 Bug report Closed Normal Processing: problems outputting raster layers from a model as a "final result" Victor Olaya 2018-06-01 05:41 AM

18215 Bug report Closed Normal Processing: problems outputting raster layers from a model as a "final result" Victor Olaya 2018-06-01 05:41 AM

18214 Bug report Open Normal Layer lists in processing dialogs (e.g. r.patch, raster calculator) are not updated correctly when layers are added or 

removed or renamed

Victor Olaya 2019-01-11 03:41 AM

18214 Bug report Open Normal Layer lists in processing dialogs (e.g. r.patch, raster calculator) are not updated correctly when layers are added or 

removed or renamed

Victor Olaya 2019-01-11 03:41 AM

18213 Bug report Closed Low Processing modeler - undocked panes should be closed when the modeler is closed Victor Olaya 2018-03-01 12:32 PM

18213 Bug report Closed Low Processing modeler - undocked panes should be closed when the modeler is closed Victor Olaya 2018-03-01 12:32 PM

18153 Bug report Closed Normal When loading a raster style from .qml the resampling options are not read in correctly. 2019-01-27 12:41 AM

18153 Bug report Closed Normal When loading a raster style from .qml the resampling options are not read in correctly. 2019-01-27 12:41 AM

18097 Bug report Closed High r.surf.contour does not work in a processing model in QGIS 3 Victor Olaya 2018-07-10 09:38 AM

18097 Bug report Closed High r.surf.contour does not work in a processing model in QGIS 3 Victor Olaya 2018-07-10 09:38 AM

18095 Bug report Closed Normal Grass algorithm outputs do not correctly work within models Victor Olaya 2018-09-25 04:00 AM

18095 Bug report Closed Normal Grass algorithm outputs do not correctly work within models Victor Olaya 2018-09-25 04:00 AM

18085 Feature request Open Low Enhancement: make processing "history" window modeless Victor Olaya 2018-02-13 07:45 AM

18085 Feature request Open Low Enhancement: make processing "history" window modeless Victor Olaya 2018-02-13 07:45 AM

18084 Bug report Closed Low Inconsistent titles in file save dialogs in QGIS 3 Alessandro 

Pasotti

2018-02-21 05:54 PM

18084 Bug report Closed Low Inconsistent titles in file save dialogs in QGIS 3 Alessandro 

Pasotti

2018-02-21 05:54 PM

18082 Bug report Closed Normal using "v.external" as Processing option (to handle input vectors) is not working 2019-02-09 11:02 AM

18082 Bug report Closed Normal using "v.external" as Processing option (to handle input vectors) is not working 2019-02-09 11:02 AM

18009 Bug report Closed Normal r.tile fails only on Windows (2.18.16 and master) Victor Olaya 2018-11-11 01:32 PM

18009 Bug report Closed Normal r.tile fails only on Windows (2.18.16 and master) Victor Olaya 2018-11-11 01:32 PM

17928 Feature request Closed Normal Need a way to distinguish between outputs from more than one use of the same algorithm when building a model. Victor Olaya 2018-01-23 06:31 AM

17928 Feature request Closed Normal Need a way to distinguish between outputs from more than one use of the same algorithm when building a model. Victor Olaya 2018-01-23 06:31 AM

17920 Bug report Closed Normal It is possible to use the raster calculator to crash QGIS Victor Olaya 2018-02-12 09:00 PM

17920 Bug report Closed Normal It is possible to use the raster calculator to crash QGIS Victor Olaya 2018-02-12 09:00 PM

17843 Bug report Closed Normal Can't add QGIS raster calculator in the processing modeller Mathieu Pellerin 

- nIRV

2018-11-13 09:26 AM

17843 Bug report Closed Normal Can't add QGIS raster calculator in the processing modeller Mathieu Pellerin 

- nIRV

2018-11-13 09:26 AM

17842 Feature request Closed Low Enhancement: make snapping options dialog either openable or discoverable from snapping options toolbar 2018-01-23 04:11 PM

17842 Feature request Closed Low Enhancement: make snapping options dialog either openable or discoverable from snapping options toolbar 2018-01-23 04:11 PM

17841 Bug report Closed Normal option to use live-updating color chooser dialogs is only partially implemented in QGIS 3 (i.e. only works from the 

top of the symbol tree)

2018-01-19 03:19 AM

17841 Bug report Closed Normal option to use live-updating color chooser dialogs is only partially implemented in QGIS 3 (i.e. only works from the 

top of the symbol tree)

2018-01-19 03:19 AM

17815 Bug report Closed Normal GRASS plugin tries to set method for r.in.wms twice, causing failure 2018-02-21 10:26 PM

17815 Bug report Closed Normal GRASS plugin tries to set method for r.in.wms twice, causing failure 2018-02-21 10:26 PM

17224 Bug report Closed Normal Smoothing (vigra) shown in processing but not working (osgeo4w packaging issue?) Victor Olaya 2017-10-02 05:18 PM
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17224 Bug report Closed Normal Smoothing (vigra) shown in processing but not working (osgeo4w packaging issue?) Victor Olaya 2017-10-02 05:18 PM

17210 Bug report Closed High Can crash gdal raster calculator by using a layer that was newly created and then removed Victor Olaya 2017-10-03 03:43 PM

17210 Bug report Closed High Can crash gdal raster calculator by using a layer that was newly created and then removed Victor Olaya 2017-10-03 03:43 PM

17136 Bug report Closed Normal Processing error: "Could not open SAGA algorithm: RiverGridGeneration.txt" Victor Olaya 2017-10-02 10:40 AM

17136 Bug report Closed Normal Processing error: "Could not open SAGA algorithm: RiverGridGeneration.txt" Victor Olaya 2017-10-02 10:40 AM

14019 Bug report Closed Normal Problems with a field where precision = length 2016-01-30 11:55 PM

14019 Bug report Closed Normal Problems with a field where precision = length 2016-01-30 11:55 PM

8550 Bug report Closed Low Huge icons on buttons in browser panel 2016-05-23 07:44 AM

8550 Bug report Closed Low Huge icons on buttons in browser panel 2016-05-23 07:44 AM

8313 Feature request Open Low Allow access to the startup tips from the help menu 2017-05-01 12:48 AM

8313 Feature request Open Low Allow access to the startup tips from the help menu 2017-05-01 12:48 AM

8312 Bug report Closed Normal Startup tips are in a modal dialogue, but clicking on the main QGIS window does not raise it to the top 2016-01-27 12:22 PM

8312 Bug report Closed Normal Startup tips are in a modal dialogue, but clicking on the main QGIS window does not raise it to the top 2016-01-27 12:22 PM

8306 Bug report Closed Normal Improvements to "Mailing lists" startup tip 2016-05-23 08:26 AM

8306 Bug report Closed Normal Improvements to "Mailing lists" startup tip 2016-05-23 08:26 AM

8305 Bug report Closed Normal Help viewer process running in the background with no help viewer (or even QGIS) open 2016-02-25 07:22 AM

8305 Bug report Closed Normal Help viewer process running in the background with no help viewer (or even QGIS) open 2016-02-25 07:22 AM

8276 Bug report Closed Normal crashes related to gdal ECW plugin 2013-07-17 04:18 AM

8276 Bug report Closed Normal crashes related to gdal ECW plugin 2013-07-17 04:18 AM

8122 Bug report Closed Low Scroll bar in new plugin manager doesn't work properly Borys Jurgiel 2013-06-20 12:26 AM

8122 Bug report Closed Low Scroll bar in new plugin manager doesn't work properly Borys Jurgiel 2013-06-20 12:26 AM

7044 Feature request Open Normal list all layers that the current layer is joined to 2017-05-01 12:48 AM

7044 Feature request Open Normal list all layers that the current layer is joined to 2017-05-01 12:48 AM

6944 Feature request Open Normal Node tool unselects nodes after moving multiple-selected nodes 2017-05-01 12:48 AM

6944 Feature request Open Normal Node tool unselects nodes after moving multiple-selected nodes 2017-05-01 12:48 AM

6864 Bug report Closed Low "number of candidates" setting is ignored in composer maps 2016-10-10 05:04 PM

6864 Bug report Closed Low "number of candidates" setting is ignored in composer maps 2016-10-10 05:04 PM

6730 Bug report Closed Normal Layer properties window expands to much wider than the screen if layer has a very long field name 2016-04-09 11:40 AM

6730 Bug report Closed Normal Layer properties window expands to much wider than the screen if layer has a very long field name 2016-04-09 11:40 AM

6727 Bug report Closed Normal CRS functions are enabled for non-spatial tables 2019-03-09 04:04 PM

6727 Bug report Closed Normal CRS functions are enabled for non-spatial tables 2019-03-09 04:04 PM

6726 Bug report Closed Severe/Regression Query builder quotes field names with spaces twice; resulting query fails 2013-01-06 09:02 AM

6726 Bug report Closed Severe/Regression Query builder quotes field names with spaces twice; resulting query fails 2013-01-06 09:02 AM

6725 Bug report Closed Normal state of toggle editing button changes even when you click cancel 2012-12-31 04:16 PM

6725 Bug report Closed Normal state of toggle editing button changes even when you click cancel 2012-12-31 04:16 PM

6715 Bug report Closed Normal attribute table: negative numbers and nulls do not sort as expected 2013-01-06 07:29 AM

6715 Bug report Closed Normal attribute table: negative numbers and nulls do not sort as expected 2013-01-06 07:29 AM

6713 Feature request Open Normal Rule based renderer gui enhancements: copy/paste; refine>use expression 2017-05-01 12:48 AM

6713 Feature request Open Normal Rule based renderer gui enhancements: copy/paste; refine>use expression 2017-05-01 12:48 AM

6712 Bug report Closed Normal Strange projection issue - layer is displayed in different location after toggling off and then on 2015-11-11 03:14 AM

6712 Bug report Closed Normal Strange projection issue - layer is displayed in different location after toggling off and then on 2015-11-11 03:14 AM

6711 Feature request Open Normal Use more robust format (e.g. standard csv) when copying features to an external program 2017-05-01 12:48 AM

6711 Feature request Open Normal Use more robust format (e.g. standard csv) when copying features to an external program 2017-05-01 12:48 AM

6710 Bug report Closed Normal QGIS appears to support editing joined tables, but it really does not 2014-10-11 07:03 AM

6710 Bug report Closed Normal QGIS appears to support editing joined tables, but it really does not 2014-10-11 07:03 AM

6709 Bug report Closed Low Creating a shapefile fails silently when you don't have permissions (should have an error message, consistent with 

other actions)

2014-06-21 12:54 PM

6709 Bug report Closed Low Creating a shapefile fails silently when you don't have permissions (should have an error message, consistent with 

other actions)

2014-06-21 12:54 PM

6708 Bug report Closed Low "Refine current rules" is enabled when no rules are selected 2015-12-03 04:47 AM

6708 Bug report Closed Low "Refine current rules" is enabled when no rules are selected 2015-12-03 04:47 AM

6707 Feature request Open Normal "Save as" - Allow to specify field names when they need to be shortened Marco 

Hugentobler

2017-05-01 12:48 AM

6707 Feature request Open Normal "Save as" - Allow to specify field names when they need to be shortened Marco 

Hugentobler

2017-05-01 12:48 AM

6706 Feature request Open Normal "View feature form" should be available for the "run feature action tool" 2017-05-02 03:29 PM

6706 Feature request Open Normal "View feature form" should be available for the "run feature action tool" 2017-05-02 03:29 PM

6705 Bug report Closed Normal Arrow indicates attribute table is sorted by default by the first column.  It is not! 2015-11-22 06:35 AM

6705 Bug report Closed Normal Arrow indicates attribute table is sorted by default by the first column.  It is not! 2015-11-22 06:35 AM

6704 Bug report Closed Normal Legend shows same symbol for all rules when "show feature count" is enabled 2015-11-11 03:43 AM

6704 Bug report Closed Normal Legend shows same symbol for all rules when "show feature count" is enabled 2015-11-11 03:43 AM

6703 Bug report Closed Low Vector transparency is not reported consistently 2015-11-11 03:37 AM

6703 Bug report Closed Low Vector transparency is not reported consistently 2015-11-11 03:37 AM

6592 Bug report Closed Low SQL where clause widget does not use plain text 2015-11-11 03:11 AM

6592 Bug report Closed Low SQL where clause widget does not use plain text 2015-11-11 03:11 AM

6501 Bug report Closed Severe/Regression Crash when joining a shape file to a csv file 2012-12-13 03:02 PM

6501 Bug report Closed Severe/Regression Crash when joining a shape file to a csv file 2012-12-13 03:02 PM

6495 Feature request Closed Normal Use list view instead of combobox to select edit widget 2012-10-11 05:24 AM

6495 Feature request Closed Normal Use list view instead of combobox to select edit widget 2012-10-11 05:24 AM

6494 Feature request Closed Normal "Show selected features" setting should cooperate with the override in the attribute table window 2015-12-22 12:21 PM

6494 Feature request Closed Normal "Show selected features" setting should cooperate with the override in the attribute table window 2015-12-22 12:21 PM

6492 Bug report Closed Normal Save-as to csv fails 2014-04-08 09:11 PM

6492 Bug report Closed Normal Save-as to csv fails 2014-04-08 09:11 PM

6445 Feature request Closed Normal Better documentation for the Intersect and Clip tools 2018-02-19 02:45 PM

6445 Feature request Closed Normal Better documentation for the Intersect and Clip tools 2018-02-19 02:45 PM

6428 Bug report Closed Low Gui: horizontal spacer for "marker line" symbols seems out of place 2015-07-12 07:11 PM

6428 Bug report Closed Low Gui: horizontal spacer for "marker line" symbols seems out of place 2015-07-12 07:11 PM

6418 Bug report Closed High Crash when zooming on a polyline memory layer with markers placed "on central point" 2013-06-02 07:24 AM

6418 Bug report Closed High Crash when zooming on a polyline memory layer with markers placed "on central point" 2013-06-02 07:24 AM

6407 Bug report Closed Normal Sometimes QGIS inserts extra  blank lines in the project macros when saving 2014-06-22 03:33 PM

6407 Bug report Closed Normal Sometimes QGIS inserts extra  blank lines in the project macros when saving 2014-06-22 03:33 PM

6406 Bug report Closed Normal Project Macros are silently disabled when you use 3 of the 4 methods of opening a project 2012-10-03 04:21 PM

6406 Bug report Closed Normal Project Macros are silently disabled when you use 3 of the 4 methods of opening a project 2012-10-03 04:21 PM

6400 Feature request Open Normal Add ability to create a new dbf table 2017-05-01 12:48 AM

6400 Feature request Open Normal Add ability to create a new dbf table 2017-05-01 12:48 AM

6399 Bug report Closed Low "Layer>Create new GPX layer" should be in "new" submenu 2013-06-11 04:42 PM
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6399 Bug report Closed Low "Layer>Create new GPX layer" should be in "new" submenu 2013-06-11 04:42 PM

6397 Feature request Closed Normal save and restore the command history in the Python console 2015-11-09 06:13 AM

6397 Feature request Closed Normal save and restore the command history in the Python console 2015-11-09 06:13 AM

6396 Bug report Closed Normal Forward transform error is not handled gracefully Magnus 

Homann

2012-09-24 06:59 AM

6396 Bug report Closed Normal Forward transform error is not handled gracefully Magnus 

Homann

2012-09-24 06:59 AM

6369 Bug report Closed Normal vsizip - relative paths not used & can't update path in "missing layers" dialogue 2019-03-09 04:04 PM

6369 Bug report Closed Normal vsizip - relative paths not used & can't update path in "missing layers" dialogue 2019-03-09 04:04 PM

6353 Bug report Closed Normal Field calculator displays real values in the attribute table instead of rounding them to the field precision 2015-11-10 04:18 AM

6353 Bug report Closed Normal Field calculator displays real values in the attribute table instead of rounding them to the field precision 2015-11-10 04:18 AM

6352 Bug report Closed Normal In some cases the field calculator does not show a preview at first 2015-01-06 06:06 AM

6352 Bug report Closed Normal In some cases the field calculator does not show a preview at first 2015-01-06 06:06 AM

6351 Bug report Closed Normal field calculator: correct calculation, but nulls written to table 2015-11-09 05:59 AM

6351 Bug report Closed Normal field calculator: correct calculation, but nulls written to table 2015-11-09 05:59 AM

6242 Feature request Open Normal Improvements to layer list (editable and labelling icons/buttons) 2017-05-01 12:48 AM

6242 Feature request Open Normal Improvements to layer list (editable and labelling icons/buttons) 2017-05-01 12:48 AM

6231 Feature request Open Normal Should be able to use groups/filter etc to select styles for import/export 2017-05-01 12:48 AM

6231 Feature request Open Normal Should be able to use groups/filter etc to select styles for import/export 2017-05-01 12:48 AM

6230 Bug report Closed Normal Layer may become unselected after "paste style" 2015-12-20 10:39 AM

6230 Bug report Closed Normal Layer may become unselected after "paste style" 2015-12-20 10:39 AM

6225 Bug report Closed Low list of layers in zip shown a second time if none selected Etienne 

Tourigny

2012-08-27 03:59 PM

6225 Bug report Closed Low list of layers in zip shown a second time if none selected Etienne 

Tourigny

2012-08-27 03:59 PM

6203 Feature request Closed Normal Should allow adding symbol layers in new symbology dialogue even when an existing symbol layer is selected 2015-11-10 05:23 AM

6203 Feature request Closed Normal Should allow adding symbol layers in new symbology dialogue even when an existing symbol layer is selected 2015-11-10 05:23 AM

6193 Bug report Closed Normal Can't load layers from a zip a 2nd time, after it is modified (need to restart QGIS) 2019-03-09 04:04 PM

6193 Bug report Closed Normal Can't load layers from a zip a 2nd time, after it is modified (need to restart QGIS) 2019-03-09 04:04 PM

6186 Bug report Closed Low "Build pyramids internally if possible" implies that if not possible, the pyramids will be automatically built externally 2019-03-09 04:04 PM

6186 Bug report Closed Low "Build pyramids internally if possible" implies that if not possible, the pyramids will be automatically built externally 2019-03-09 04:04 PM

6185 Bug report Closed Low Can't write pyramids to separate .ovr file if raster file is read-only 2019-03-10 04:19 PM

6185 Bug report Closed Low Can't write pyramids to separate .ovr file if raster file is read-only 2019-03-10 04:19 PM

6184 Bug report Closed Low Map canvas does not update after "paste style" 2013-02-24 05:42 PM

6184 Bug report Closed Low Map canvas does not update after "paste style" 2013-02-24 05:42 PM

6183 Feature request Closed Normal There is no check that the style of a vector layer matches the type of data (e.g. line vs polygon) 2015-11-10 05:16 AM

6183 Feature request Closed Normal There is no check that the style of a vector layer matches the type of data (e.g. line vs polygon) 2015-11-10 05:16 AM

6182 Bug report Closed Severe/Regression Crash when printing without "print to raster", with a transparent raster layer 2012-10-20 07:14 PM

6182 Bug report Closed Severe/Regression Crash when printing without "print to raster", with a transparent raster layer 2012-10-20 07:14 PM

6181 Bug report Closed Severe/Regression Crash when trying to load a composer template Marco 

Hugentobler

2012-08-24 08:59 PM

6181 Bug report Closed Severe/Regression Crash when trying to load a composer template Marco 

Hugentobler

2012-08-24 08:59 PM

6165 Bug report Closed Low Overlapping widgets in expression builder dialog Nathan 

Woodrow

2013-01-28 05:59 AM

6165 Bug report Closed Low Overlapping widgets in expression builder dialog Nathan 

Woodrow

2013-01-28 05:59 AM

6105 Bug report Closed Low broken link to old wiki in plugin_template readme 2012-09-04 11:46 PM

6105 Bug report Closed Low broken link to old wiki in plugin_template readme 2012-09-04 11:46 PM

6053 Bug report Closed Low Startup tip misrepresents the GPL 2012-07-16 11:19 PM

6053 Bug report Closed Low Startup tip misrepresents the GPL 2012-07-16 11:19 PM

5975 Feature request Open Normal "Zoom history" panel like the "undo history" 2017-05-01 12:48 AM

5975 Feature request Open Normal "Zoom history" panel like the "undo history" 2017-05-01 12:48 AM

5868 Feature request Closed Low Full-featured, user-friendly drawing/annotation tools 2017-01-29 03:12 PM

5868 Feature request Closed Low Full-featured, user-friendly drawing/annotation tools 2017-01-29 03:12 PM

5780 Bug report Closed Low Most labels in menus are in Title Case 2019-03-09 04:04 PM

5780 Bug report Closed Low Most labels in menus are in Title Case 2019-03-09 04:04 PM

5632 Bug report Closed Low Grammar mistake in CRS dialogue - "coordinate references systems" 2012-05-23 09:40 PM

5632 Bug report Closed Low Grammar mistake in CRS dialogue - "coordinate references systems" 2012-05-23 09:40 PM

5620 Bug report Closed Normal libqgis_core in the build directory is not used when running crssync during build 2012-07-11 01:07 AM

5620 Bug report Closed Normal libqgis_core in the build directory is not used when running crssync during build 2012-07-11 01:07 AM

5173 Bug report Closed Normal Shape file field precision includes the . when saving, but not when editing in the attribute table 2015-12-20 11:22 PM

5173 Bug report Closed Normal Shape file field precision includes the . when saving, but not when editing in the attribute table 2015-12-20 11:22 PM

5172 Bug report Closed Normal When a memory layer is "saved as" a shapefile, any null values in the attribute table are converted to zeros 2012-05-28 02:56 PM

5172 Bug report Closed Normal When a memory layer is "saved as" a shapefile, any null values in the attribute table are converted to zeros 2012-05-28 02:56 PM

5157 Bug report Closed Normal Areas should be in expressed as m² or km², not m2 or km2" 2012-04-04 03:37 PM

5157 Bug report Closed Normal Areas should be in expressed as m² or km², not m2 or km2" 2012-04-04 03:37 PM

5156 Bug report Closed Low Measure tool lines should be erased when switching to another measure tool Magnus 

Homann

2012-09-04 10:55 AM

5156 Bug report Closed Low Measure tool lines should be erased when switching to another measure tool Magnus 

Homann

2012-09-04 10:55 AM

5155 Bug report Closed Normal memory layer attribute fields are combined when a memory layer or columns in a memory layer are deleted 2015-12-13 10:29 PM

5155 Bug report Closed Normal memory layer attribute fields are combined when a memory layer or columns in a memory layer are deleted 2015-12-13 10:29 PM

5154 Bug report Closed Normal Need to check that precision<field width when adding a column 2016-01-30 11:55 PM

5154 Bug report Closed Normal Need to check that precision<field width when adding a column 2016-01-30 11:55 PM

5153 Bug report Closed Normal Unexpected rounding in field calculator (documentation needed) Nathan 

Woodrow

2014-12-08 11:40 PM

5153 Bug report Closed Normal Unexpected rounding in field calculator (documentation needed) Nathan 

Woodrow

2014-12-08 11:40 PM

5152 Feature request Open Normal ability to temporarily override or toggle all snapping 2017-05-01 12:50 AM

5152 Feature request Open Normal ability to temporarily override or toggle all snapping 2017-05-01 12:50 AM

5134 Bug report Closed Low Expression builder: missing help message is incomplete for some operators 2012-03-09 08:53 AM

5134 Bug report Closed Low Expression builder: missing help message is incomplete for some operators 2012-03-09 08:53 AM

5126 Feature request Closed Normal "Run feature action" tool should run the action for all matching features Giuseppe 

Sucameli

2012-03-14 03:23 AM
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5126 Feature request Closed Normal "Run feature action" tool should run the action for all matching features Giuseppe 

Sucameli

2012-03-14 03:23 AM

5125 Bug report Closed Normal Inconsistent behaviour - whether or not newly added layers are automatically selected 2015-12-20 10:38 AM

5125 Bug report Closed Normal Inconsistent behaviour - whether or not newly added layers are automatically selected 2015-12-20 10:38 AM

5118 Bug report Closed Low Floating controls in the print composer do not close (and continue to operate) when you close the composer Nathan 

Woodrow

2012-05-04 03:24 AM

5118 Bug report Closed Low Floating controls in the print composer do not close (and continue to operate) when you close the composer Nathan 

Woodrow

2012-05-04 03:24 AM

5115 Feature request Open Low Save more than one style in a .qml file and give user a choice when loading the layer 2019-01-10 10:59 AM

5115 Feature request Open Low Save more than one style in a .qml file and give user a choice when loading the layer 2019-01-10 10:59 AM

5032 Bug report Closed High `log(100,10)` does not give the same result as `log10(100)`! 2012-02-22 06:28 PM

5032 Bug report Closed High `log(100,10)` does not give the same result as `log10(100)`! 2012-02-22 06:28 PM

5030 Bug report Closed High Incorrect layer CRS is shown when opening CRS selector more than once (recently used list is cycling) 2012-05-28 01:51 PM

5030 Bug report Closed High Incorrect layer CRS is shown when opening CRS selector more than once (recently used list is cycling) 2012-05-28 01:51 PM

5006 Feature request Closed Normal The user can miss any error messages on startup because there is no taskbar entry 2015-12-07 10:03 AM

5006 Feature request Closed Normal The user can miss any error messages on startup because there is no taskbar entry 2015-12-07 10:03 AM

5005 Feature request Open Normal Display layer's native CRS, and provide the ability to remove any override 2018-01-10 03:48 AM

5005 Feature request Open Normal Display layer's native CRS, and provide the ability to remove any override 2018-01-10 03:48 AM

4887 Feature request Closed Low save choice of "Item reference point" for composer items. 2014-05-20 08:12 PM

4887 Feature request Closed Low save choice of "Item reference point" for composer items. 2014-05-20 08:12 PM

4874 Feature request Open Low button(s) to scroll the attribute table to the selected feature(s) 2017-05-01 12:50 AM

4874 Feature request Open Low button(s) to scroll the attribute table to the selected feature(s) 2017-05-01 12:50 AM

4641 Bug report Closed Normal Colours are incorrect in exported PDF 2019-03-09 04:04 PM

4641 Bug report Closed Normal Colours are incorrect in exported PDF 2019-03-09 04:04 PM

4636 Bug report Closed Normal Selecting/Deleting in attribute table does not work correctly for layers with no attributes (crashes in one situation!) 2012-01-12 02:28 PM

4636 Bug report Closed Normal Selecting/Deleting in attribute table does not work correctly for layers with no attributes (crashes in one situation!) 2012-01-12 02:28 PM

4635 Bug report Closed Normal Attribute table edit button: only changes to columns are refreshed when Discarding changes 2012-02-02 01:06 PM

4635 Bug report Closed Normal Attribute table edit button: only changes to columns are refreshed when Discarding changes 2012-02-02 01:06 PM

4582 Bug report Closed Low Building trunk with MS vcexpress 2010: INSTALL fails 2014-06-28 10:27 AM

4582 Bug report Closed Low Building trunk with MS vcexpress 2010: INSTALL fails 2014-06-28 10:27 AM

4581 Bug report Closed Normal Simple fill border drawn like it is not "closed" 2015-12-05 05:53 AM

4581 Bug report Closed Normal Simple fill border drawn like it is not "closed" 2015-12-05 05:53 AM

4551 Feature request Closed Low Expression parser: automatic conversion to string should be consistent 2012-06-22 11:20 AM

4551 Feature request Closed Low Expression parser: automatic conversion to string should be consistent 2012-06-22 11:20 AM

4496 Feature request Closed Low Simplify user interface in composer table widget Marco 

Hugentobler

2014-09-22 01:56 AM

4496 Feature request Closed Low Simplify user interface in composer table widget Marco 

Hugentobler

2014-09-22 01:56 AM

4455 Feature request Closed Normal Feature: update map extent when changing project CRS 2011-10-28 01:04 AM

4455 Feature request Closed Normal Feature: update map extent when changing project CRS 2011-10-28 01:04 AM

4441 Bug report Closed Normal Expression parser: some expressions evaluate to NULL when they shouldn't Martin Dobias 2011-11-04 03:47 AM

4441 Bug report Closed Normal Expression parser: some expressions evaluate to NULL when they shouldn't Martin Dobias 2011-11-04 03:47 AM

4405 Feature request Closed Normal Updates to the field calculator context help 2012-02-01 07:07 AM

4405 Feature request Closed Normal Updates to the field calculator context help 2012-02-01 07:07 AM

4404 Bug report Closed Normal NZMG and other NZGD49 based CRSs are wrong 2019-03-09 04:04 PM

4404 Bug report Closed Normal NZMG and other NZGD49 based CRSs are wrong 2019-03-09 04:04 PM

4375 Bug report Closed Normal Zoom to layer extent does not work for a point layer with a single point. 2015-12-20 11:26 PM

4375 Bug report Closed Normal Zoom to layer extent does not work for a point layer with a single point. 2015-12-20 11:26 PM

4362 Feature request Closed Low File dialogues should recognise VRT files with .ovf and .ovr extension 2015-12-12 12:01 PM

4362 Feature request Closed Low File dialogues should recognise VRT files with .ovf and .ovr extension 2015-12-12 12:01 PM

4361 Bug report Closed Low Edit button is not updated when provider query makes a layer read-only 2019-03-09 04:04 PM

4361 Bug report Closed Low Edit button is not updated when provider query makes a layer read-only 2019-03-09 04:04 PM

4349 Feature request Closed Normal Enable a user to edit the gdaltools commands. 2011-10-05 03:52 AM

4349 Feature request Closed Normal Enable a user to edit the gdaltools commands. 2011-10-05 03:52 AM

4348 Feature request Closed Normal Add features like "creation options" and "no data" for all gdaltools 2018-05-16 02:10 PM

4348 Feature request Closed Normal Add features like "creation options" and "no data" for all gdaltools 2018-05-16 02:10 PM

4347 Bug report Closed Low raster and vector rendering mismatched by 1 pixel at some zoom levels 2012-10-06 02:43 AM

4347 Bug report Closed Low raster and vector rendering mismatched by 1 pixel at some zoom levels 2012-10-06 02:43 AM

4346 Feature request Closed Low startup tip suggestion 2016-01-03 06:11 AM

4346 Feature request Closed Low startup tip suggestion 2016-01-03 06:11 AM

4298 Bug report Closed Low Patch: minor typos in the code 2011-09-30 10:21 AM

4298 Bug report Closed Low Patch: minor typos in the code 2011-09-30 10:21 AM

4281 Feature request In Progress Low More user friendly handling of geometryless tables and layers loaded by a query with no matching features 2019-01-10 11:12 AM

4281 Feature request In Progress Low More user friendly handling of geometryless tables and layers loaded by a query with no matching features 2019-01-10 11:12 AM

4280 Feature request Open Normal Add ability to refresh the extent of a WFS layer 2017-05-01 12:50 AM

4280 Feature request Open Normal Add ability to refresh the extent of a WFS layer 2017-05-01 12:50 AM

4276 Feature request Closed Normal Ability to refresh browser pane 2011-09-09 03:25 AM

4276 Feature request Closed Normal Ability to refresh browser pane 2011-09-09 03:25 AM

4275 Feature request Closed Low Strip off file extension for layer name when adding via the Browser pane 2011-11-09 07:24 AM

4275 Feature request Closed Low Strip off file extension for layer name when adding via the Browser pane 2011-11-09 07:24 AM

4270 Feature request Open Normal Attribute Table - make keyboard cell navigation more consistent 2017-05-01 12:50 AM

4270 Feature request Open Normal Attribute Table - make keyboard cell navigation more consistent 2017-05-01 12:50 AM

4262 Feature request Closed Low Ability for the identify tool to run a "default action", not always the "Edit feature form" action Giuseppe 

Sucameli

2012-01-11 07:17 AM

4262 Feature request Closed Low Ability for the identify tool to run a "default action", not always the "Edit feature form" action Giuseppe 

Sucameli

2012-01-11 07:17 AM

4252 Feature request Closed Normal different built-in tools calculate inconsistent polygon areas Magnus 

Homann

2016-02-15 05:13 PM

4252 Feature request Closed Normal different built-in tools calculate inconsistent polygon areas Magnus 

Homann

2016-02-15 05:13 PM

4251 Feature request Closed Low "keep base unit" option should affect "derived" identify results 2016-02-27 04:19 PM

4251 Feature request Closed Low "keep base unit" option should affect "derived" identify results 2016-02-27 04:19 PM

4236 Feature request Open Normal Add ability to (over)write CRS for an existing raster file e.g. to geotif or to .aux.xml file for jpg + jgw 2018-10-05 12:13 PM

4236 Feature request Open Normal Add ability to (over)write CRS for an existing raster file e.g. to geotif or to .aux.xml file for jpg + jgw 2018-10-05 12:13 PM

4211 Bug report Closed Low Enhancement: make "actions" tab more consistent and less confusing 2014-06-29 10:13 AM
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4211 Bug report Closed Low Enhancement: make "actions" tab more consistent and less confusing 2014-06-29 10:13 AM

4210 Bug report Closed Normal Layer actions: "capture output" option is forgotten when selecting an action in the layer properties Giuseppe 

Sucameli

2012-03-13 05:11 PM

4210 Bug report Closed Normal Layer actions: "capture output" option is forgotten when selecting an action in the layer properties Giuseppe 

Sucameli

2012-03-13 05:11 PM

4185 Bug report Closed Low Globe and zonal statistics plugins do not properly unload Pirmin Kalberer 2013-08-28 05:50 AM

4185 Bug report Closed Low Globe and zonal statistics plugins do not properly unload Pirmin Kalberer 2013-08-28 05:50 AM

4179 Feature request Closed Low Add "?" tool to help menu (currently it is only on the toolbar) 2012-01-11 06:33 AM

4179 Feature request Closed Low Add "?" tool to help menu (currently it is only on the toolbar) 2012-01-11 06:33 AM

4178 Bug report Closed Normal Plugin manager does not show c++ plugins in additional plugin path 2012-01-23 10:25 AM

4178 Bug report Closed Normal Plugin manager does not show c++ plugins in additional plugin path 2012-01-23 10:25 AM

4177 Bug report Closed Low restart needed to hide some disabled plugins 2011-08-17 03:36 AM

4177 Bug report Closed Low restart needed to hide some disabled plugins 2011-08-17 03:36 AM

4174 Bug report Closed Normal Rasters are not rendered again when changing project CRS with render caching enabled 2012-05-23 08:37 PM

4174 Bug report Closed Normal Rasters are not rendered again when changing project CRS with render caching enabled 2012-05-23 08:37 PM

4160 Feature request Closed Normal Enhancements to multiband raster styling to make it more user friendly / consistent 2019-03-10 03:58 PM

4160 Feature request Closed Normal Enhancements to multiband raster styling to make it more user friendly / consistent 2019-03-10 03:58 PM

4159 Bug report Closed Normal Should detect a grayscale image with an alpha channel as grayscale (and related issues) 2015-06-04 08:08 AM

4159 Bug report Closed Normal Should detect a grayscale image with an alpha channel as grayscale (and related issues) 2015-06-04 08:08 AM

4134 Bug report Closed Low trying to connect to a non-spatialite sqlite db makes the mouse pointer into an hourglass 2011-12-09 09:51 AM

4134 Bug report Closed Low trying to connect to a non-spatialite sqlite db makes the mouse pointer into an hourglass 2011-12-09 09:51 AM

4133 Bug report Closed Low Identify results - previous state (location, docked status, size) is not saved 2011-10-27 07:45 PM

4133 Bug report Closed Low Identify results - previous state (location, docked status, size) is not saved 2011-10-27 07:45 PM

4123 Feature request Closed Normal "single symbol", "categorised" and "graduated" renderering should be removed as they are like subsets of "rule 

based" rendering

2015-10-09 08:06 PM

4123 Feature request Closed Normal "single symbol", "categorised" and "graduated" renderering should be removed as they are like subsets of "rule 

based" rendering

2015-10-09 08:06 PM

4122 Feature request Open Low Inconsistency: some fill symbol layer types also create an outline, others don't 2017-05-01 12:50 AM

4122 Feature request Open Low Inconsistency: some fill symbol layer types also create an outline, others don't 2017-05-01 12:50 AM

4121 Bug report Closed Normal MSVC: build fails due to "'fabs' : ambiguous call to overloaded function" 2011-08-01 02:45 AM

4121 Bug report Closed Normal MSVC: build fails due to "'fabs' : ambiguous call to overloaded function" 2011-08-01 02:45 AM

4110 Bug report Closed Low order of layers changes when they are added to a group 2015-12-13 07:39 PM

4110 Bug report Closed Low order of layers changes when they are added to a group 2015-12-13 07:39 PM

4109 Bug report Closed High Save-as to "original CRS" incorrectly reprojects if OTF reprojection is disabled 2012-02-06 02:42 PM

4109 Bug report Closed High Save-as to "original CRS" incorrectly reprojects if OTF reprojection is disabled 2012-02-06 02:42 PM

4108 Bug report Closed Normal Switching from new to old polygon symbology then back again ends up with polyline symbology 2015-05-22 12:58 PM

4108 Bug report Closed Normal Switching from new to old polygon symbology then back again ends up with polyline symbology 2015-05-22 12:58 PM

4103 Feature request Closed Normal "Snap Tolerance" dialogue text needs to be updated 2013-05-29 11:46 AM

4103 Feature request Closed Normal "Snap Tolerance" dialogue text needs to be updated 2013-05-29 11:46 AM

4102 Bug report Closed Normal Zoom to layer extent only considers the first part of a multipolygon 2015-12-03 09:53 PM

4102 Bug report Closed Normal Zoom to layer extent only considers the first part of a multipolygon 2015-12-03 09:53 PM

4101 Bug report Closed Normal No indication of the problem when opening a project with an unsupported layer 2019-03-09 04:04 PM

4101 Bug report Closed Normal No indication of the problem when opening a project with an unsupported layer 2019-03-09 04:04 PM

4100 Bug report Open Normal Text for two CRS dialogues is wrong (swapped) 2019-03-10 05:53 PM

4100 Bug report Open Normal Text for two CRS dialogues is wrong (swapped) 2019-03-10 05:53 PM

4099 Feature request Closed Normal Enhancement: add support for wildcards to the field calculator 2011-07-24 10:04 PM

4099 Feature request Closed Normal Enhancement: add support for wildcards to the field calculator 2011-07-24 10:04 PM

4098 Bug report Closed Normal Problems with "Advanced Search" query results 2011-07-20 03:20 AM

4098 Bug report Closed Normal Problems with "Advanced Search" query results 2011-07-20 03:20 AM

4094 Feature request Open Low Enhancement: specify background for (transparent) items in composer legend 2017-05-01 12:50 AM

4094 Feature request Open Low Enhancement: specify background for (transparent) items in composer legend 2017-05-01 12:50 AM

4093 Feature request Closed Normal Specify joint style for composer frames 2014-04-18 01:40 AM

4093 Feature request Closed Normal Specify joint style for composer frames 2014-04-18 01:40 AM

4092 Bug report Closed Low Cancel, OK and Apply buttons behave incorrectly and inconsistently in "Settings>Project Properties" 2019-03-09 04:04 PM

4092 Bug report Closed Low Cancel, OK and Apply buttons behave incorrectly and inconsistently in "Settings>Project Properties" 2019-03-09 04:04 PM

4090 Bug report Closed Normal help text is invisible for xat(n) and yat(n) 2011-07-19 04:27 PM

4090 Bug report Closed Normal help text is invisible for xat(n) and yat(n) 2011-07-19 04:27 PM

4079 Bug report Closed Normal (Some) features with invalid geometries not labelled 2019-03-10 03:41 PM

4079 Bug report Closed Normal (Some) features with invalid geometries not labelled 2019-03-10 03:41 PM

4078 Feature request Closed Low Enable CRS conversion in field calculator 2015-11-10 07:15 AM

4078 Feature request Closed Low Enable CRS conversion in field calculator 2015-11-10 07:15 AM

4074 Bug report Closed Low "invert color map" is not checked when it has been enabled for a layer 2012-05-19 07:53 PM

4074 Bug report Closed Low "invert color map" is not checked when it has been enabled for a layer 2012-05-19 07:53 PM

4073 Bug report Closed Low Map overview is not updated when changing layer symbology 2015-12-03 07:22 AM

4073 Bug report Closed Low Map overview is not updated when changing layer symbology 2015-12-03 07:22 AM

4072 Bug report Closed Low Window title: project name is cut off at the first dot 2011-07-19 08:23 PM

4072 Bug report Closed Low Window title: project name is cut off at the first dot 2011-07-19 08:23 PM

4069 Feature request Reopened Normal Enhancement: ability to search for a plugin to run 2018-04-03 11:55 PM

4069 Feature request Reopened Normal Enhancement: ability to search for a plugin to run 2018-04-03 11:55 PM

4061 Bug report Closed Normal building globe plugin fails: cannot open file 'QtOpenGL.lib Pirmin Kalberer 2011-07-14 07:46 PM

4061 Bug report Closed Normal building globe plugin fails: cannot open file 'QtOpenGL.lib Pirmin Kalberer 2011-07-14 07:46 PM

4060 Bug report Closed Normal building globe plugin fails: 'GUID' : ambiguous symbol Pirmin Kalberer 2011-07-14 11:17 PM

4060 Bug report Closed Normal building globe plugin fails: 'GUID' : ambiguous symbol Pirmin Kalberer 2011-07-14 11:17 PM

4059 Bug report Closed Normal building globe plugin fails: 'setenv': identifier not found Pirmin Kalberer 2011-07-14 07:47 PM

4059 Bug report Closed Normal building globe plugin fails: 'setenv': identifier not found Pirmin Kalberer 2011-07-14 07:47 PM

4056 Bug report Closed Normal when built-in SVGs are added to a composer layout paths should be relative to the install directory 2019-03-09 04:04 PM

4056 Bug report Closed Normal when built-in SVGs are added to a composer layout paths should be relative to the install directory 2019-03-09 04:04 PM

4055 Feature request Closed Normal Enhancement: display SVG symbols in themed collections instead of all together. 2016-03-07 01:19 PM

4055 Feature request Closed Normal Enhancement: display SVG symbols in themed collections instead of all together. 2016-03-07 01:19 PM

4054 Feature request Closed Low Enhancement: option in the interpolation plugin to set the extent to match that of an existing layer 2017-01-02 01:26 AM

4054 Feature request Closed Low Enhancement: option in the interpolation plugin to set the extent to match that of an existing layer 2017-01-02 01:26 AM

4012 Feature request Closed Low Feature: add hillshading as an option for raster symbology 2017-04-30 04:29 PM

4012 Feature request Closed Low Feature: add hillshading as an option for raster symbology 2017-04-30 04:29 PM

4008 Bug report Closed Normal MSVC: INSTALL fails because zonalstatistics plugin is not built 2011-07-14 07:45 PM

4008 Bug report Closed Normal MSVC: INSTALL fails because zonalstatistics plugin is not built 2011-07-14 07:45 PM

4007 Bug report Closed Normal Building t2tdoc fails on Windows: 'TEXINPUTS' is not recognized as an internal or external command 2015-12-27 04:15 PM
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4007 Bug report Closed Normal Building t2tdoc fails on Windows: 'TEXINPUTS' is not recognized as an internal or external command 2015-12-27 04:15 PM

3856 Feature request Open Low Extents of print composer maps are not updated when the project CRS changes 2017-05-01 12:50 AM

3856 Feature request Open Low Extents of print composer maps are not updated when the project CRS changes 2017-05-01 12:50 AM

3855 Bug report Closed Low Python console gets stuck if you use [Enter] from the number pad 2011-07-05 01:37 AM

3855 Bug report Closed Low Python console gets stuck if you use [Enter] from the number pad 2011-07-05 01:37 AM

3808 Feature request Closed Low get rid of annoying svg messages 2014-04-23 05:14 PM

3808 Feature request Closed Low get rid of annoying svg messages 2014-04-23 05:14 PM

3806 Feature request Open Low Make click anywhere in symbol select/identify the object (i.e. when symbol is bigger than the actual object) 2018-03-03 09:26 AM

3806 Feature request Open Low Make click anywhere in symbol select/identify the object (i.e. when symbol is bigger than the actual object) 2018-03-03 09:26 AM

3805 Feature request Open Low Snapping for select and info tools nobody - 2017-05-01 12:42 AM

3805 Feature request Open Low Snapping for select and info tools nobody - 2017-05-01 12:42 AM

3797 Feature request Closed Normal Specify joint style for Simple Markers 2016-04-02 11:24 PM

3797 Feature request Closed Normal Specify joint style for Simple Markers 2016-04-02 11:24 PM

3786 Bug report Closed Low in the composer, map labels and symbols defined in points/mm should be scaled on-screen to match the page size 2011-12-08 02:54 PM

3786 Bug report Closed Low in the composer, map labels and symbols defined in points/mm should be scaled on-screen to match the page size 2011-12-08 02:54 PM

3783 Feature request Open Normal "Screen scaling" setting to control the screen size of things defined in points or mm 2017-05-01 12:50 AM

3783 Feature request Open Normal "Screen scaling" setting to control the screen size of things defined in points or mm 2017-05-01 12:50 AM

3779 Bug report Open Low Symbols are incorrectly cropped in map canvas if rotated 2019-03-10 05:53 PM

3779 Bug report Open Low Symbols are incorrectly cropped in map canvas if rotated 2019-03-10 05:53 PM

3778 Bug report Closed Low Simple symbols rendering incorrectly in the composer and when printed nobody - 2011-05-20 02:02 PM

3778 Bug report Closed Low Simple symbols rendering incorrectly in the composer and when printed nobody - 2011-05-20 02:02 PM

3774 Bug report Closed Low selection shown in the wrong place in rotated maps nobody - 2011-05-21 02:27 PM

3774 Bug report Closed Low selection shown in the wrong place in rotated maps nobody - 2011-05-21 02:27 PM

3762 Bug report Closed Low "Cancel" does not revert a change between new and old symbology 2015-07-12 04:44 PM

3762 Bug report Closed Low "Cancel" does not revert a change between new and old symbology 2015-07-12 04:44 PM

3761 Bug report Closed Low "Cancel" button in Symbol properties dialogue has the same effect as "OK" button. 2015-08-21 12:03 PM

3761 Bug report Closed Low "Cancel" button in Symbol properties dialogue has the same effect as "OK" button. 2015-08-21 12:03 PM

3757 Bug report Closed Low "use project crs" does not work correctly nobody - 2011-04-28 09:49 PM

3757 Bug report Closed Low "use project crs" does not work correctly nobody - 2011-04-28 09:49 PM

3724 Feature request Closed Low Direct the user to the format-specific documentation for "Creation Options" 2015-11-20 07:17 AM

3724 Feature request Closed Low Direct the user to the format-specific documentation for "Creation Options" 2015-11-20 07:17 AM

3574 Bug report Closed Low Map overview and composer show vertex markers for layers in editing mode 2011-07-12 02:26 AM

3574 Bug report Closed Low Map overview and composer show vertex markers for layers in editing mode 2011-07-12 02:26 AM

3535 Feature request Closed Low Enhancement: option to open attribute table on double-click, instead of opening layer properties nobody - 2011-03-01 04:36 PM

3535 Feature request Closed Low Enhancement: option to open attribute table on double-click, instead of opening layer properties nobody - 2011-03-01 04:36 PM

3490 Bug report Closed Low Delimited text plugin does not work in trunk Gary Sherman 2011-02-16 01:57 AM

3490 Bug report Closed Low Delimited text plugin does not work in trunk Gary Sherman 2011-02-16 01:57 AM

3486 Feature request Closed Low Snapping for move tool 2017-05-01 05:42 PM

3486 Feature request Closed Low Snapping for move tool 2017-05-01 05:42 PM

3482 Feature request Open Low Enhancement: Curved labels for polygons 2017-05-01 12:50 AM

3482 Feature request Open Low Enhancement: Curved labels for polygons 2017-05-01 12:50 AM

3481 Feature request In Progress Low Enhancement: Options to stretch labels 2017-05-01 12:50 AM

3481 Feature request In Progress Low Enhancement: Options to stretch labels 2017-05-01 12:50 AM

3480 Bug report Closed Low Composer arrows and basic shapes are rasterised when printed 2014-06-03 03:30 AM

3480 Bug report Closed Low Composer arrows and basic shapes are rasterised when printed 2014-06-03 03:30 AM

3361 Feature request Open Low Enhancement: raster edge detection and snapping for digitisation and georeferencing nobody - 2017-05-01 12:42 AM

3361 Feature request Open Low Enhancement: raster edge detection and snapping for digitisation and georeferencing nobody - 2017-05-01 12:42 AM

3347 Bug report Closed Low Search query should warn when a column does not exist (instead of saying 0 matching features) nobody - 2011-02-15 01:20 AM

3347 Bug report Closed Low Search query should warn when a column does not exist (instead of saying 0 matching features) nobody - 2011-02-15 01:20 AM

3346 Bug report Closed Low Bug: composer legend - symbols and labels are not vertically aligned 2012-04-23 02:40 AM

3346 Bug report Closed Low Bug: composer legend - symbols and labels are not vertically aligned 2012-04-23 02:40 AM

3345 Bug report Closed Low Bug: Spacing is messed up in composer labels Marco 

Hugentobler

2011-03-03 02:29 PM

3345 Bug report Closed Low Bug: Spacing is messed up in composer labels Marco 

Hugentobler

2011-03-03 02:29 PM

3339 Feature request Closed Low Enhancement: "add layer" button for composer legend Nathan 

Woodrow

2010-12-20 05:49 PM

3339 Feature request Closed Low Enhancement: "add layer" button for composer legend Nathan 

Woodrow

2010-12-20 05:49 PM

3330 Bug report Closed Normal Bug: Glitches in Pretty Breaks graduated rendering 2012-10-01 03:48 PM

3330 Bug report Closed Normal Bug: Glitches in Pretty Breaks graduated rendering 2012-10-01 03:48 PM

3325 Bug report Closed Low Crash when using graduated renderer in Jenks mode with classes >=  amount of data cfarmer - 2010-12-13 07:02 AM

3325 Bug report Closed Low Crash when using graduated renderer in Jenks mode with classes >=  amount of data cfarmer - 2010-12-13 07:02 AM

3314 Bug report Closed Low Node tool does not allow multiple-selection when geometry is invalid 2012-12-30 08:41 AM

3314 Bug report Closed Low Node tool does not allow multiple-selection when geometry is invalid 2012-12-30 08:41 AM

3299 Bug report Closed Low Crash loading Mapinfo tab file with non-spatial features nobody - 2011-03-06 02:35 PM

3299 Bug report Closed Low Crash loading Mapinfo tab file with non-spatial features nobody - 2011-03-06 02:35 PM

3298 Bug report Closed Low Rule-based renderer: if rule does not use correct case, "test" succeeds, but no features are rendered Martin Dobias 2010-12-16 02:20 PM

3298 Bug report Closed Low Rule-based renderer: if rule does not use correct case, "test" succeeds, but no features are rendered Martin Dobias 2010-12-16 02:20 PM

3295 Bug report Closed Low SVG images rasterized when printing/exporting Marco 

Hugentobler

2011-05-03 01:16 AM

3295 Bug report Closed Low SVG images rasterized when printing/exporting Marco 

Hugentobler

2011-05-03 01:16 AM

3264 Bug report Closed Low When adding an attribute column need to close and reopen the attribute table to see it. nobody - 2010-11-30 12:15 AM

3264 Bug report Closed Low When adding an attribute column need to close and reopen the attribute table to see it. nobody - 2010-11-30 12:15 AM

3257 Feature request Open Low Enhancement: don't show label unless the feature is visible 2017-05-01 12:50 AM

3257 Feature request Open Low Enhancement: don't show label unless the feature is visible 2017-05-01 12:50 AM

3253 Feature request Open Low Enhancement: option to "trim other layers to match" 2017-05-01 12:50 AM

3253 Feature request Open Low Enhancement: option to "trim other layers to match" 2017-05-01 12:50 AM

3251 Bug report Closed Low PDF export creates a PDF with strange text encoding (or something) 2011-12-13 07:12 PM

3251 Bug report Closed Low PDF export creates a PDF with strange text encoding (or something) 2011-12-13 07:12 PM

3250 Bug report Closed Low Vector layers printed/exported as rasters, even when "Print as Raster" is unchecked 2013-03-20 11:49 AM

3250 Bug report Closed Low Vector layers printed/exported as rasters, even when "Print as Raster" is unchecked 2013-03-20 11:49 AM

3243 Feature request Closed Low Spatial bookmarks do not take into account CRS Richard 

Duivenvoorde

2012-01-28 10:55 AM
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3243 Feature request Closed Low Spatial bookmarks do not take into account CRS Richard 

Duivenvoorde

2012-01-28 10:55 AM

3224 Bug report Closed Low SVG export scales page content (but not page size) to 333.3% of what it should be. Marco 

Hugentobler

2010-12-14 08:21 AM

3224 Bug report Closed Low SVG export scales page content (but not page size) to 333.3% of what it should be. Marco 

Hugentobler

2010-12-14 08:21 AM

3217 Feature request Closed Low SVG/image export: Allow transparent page / no page outline. 2015-10-09 08:02 PM

3217 Feature request Closed Low SVG/image export: Allow transparent page / no page outline. 2015-10-09 08:02 PM

3016 Feature request Closed Low Add feature: File>Open project as group 2011-06-21 12:50 AM

3016 Feature request Closed Low Add feature: File>Open project as group 2011-06-21 12:50 AM

3004 Bug report Closed Low DXF is offered as a "Save as" option, but doesn't work 2011-06-19 07:44 AM

3004 Bug report Closed Low DXF is offered as a "Save as" option, but doesn't work 2011-06-19 07:44 AM

2971 Bug report Closed Low Trunk r14153 - Turning an empty layer on and off zooms the map overview in and out 2014-06-02 04:31 AM

2971 Bug report Closed Low Trunk r14153 - Turning an empty layer on and off zooms the map overview in and out 2014-06-02 04:31 AM

2970 Feature request Closed Low Unify query builders nobody - 2010-09-01 09:58 PM

2970 Feature request Closed Low Unify query builders nobody - 2010-09-01 09:58 PM

2774 Feature request Closed Low enable double-click to zoom to bookmarks nobody - 2011-06-02 08:24 AM

2774 Feature request Closed Low enable double-click to zoom to bookmarks nobody - 2011-06-02 08:24 AM

2764 Feature request Closed Low Put in status bar instead of options - "By default new layers added to the map should be displayed" 2016-04-26 02:29 AM

2764 Feature request Closed Low Put in status bar instead of options - "By default new layers added to the map should be displayed" 2016-04-26 02:29 AM

2039 Bug report Closed Low Can't drag a file into the layer manager to add a layer nobody - 2009-11-29 07:33 AM

2039 Bug report Closed Low Can't drag a file into the layer manager to add a layer nobody - 2009-11-29 07:33 AM
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